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1 Įžanga

Šioje instrukcijoje stengiamasi  supažindinti paprastą  vartotoją su pagrindiniais darbo Linux

grafinėje  aplinkoje  principais.  Rašant  remtasi  labiausiai  išvystytomis  Linux  grafinėmis

aplinkoms  GNOME  (versija  2.0.x)  bei  KDE (versija  3.0.x),  pateikiamos  šių  sąsajų  ekrano

nuotraukos bei įvairių elementų paveikslėliai.

Pradžioje aprašyti naudojimosi pele bei klaviatūra pagrindai, paaiškinti pagrindiniai terminai.

Toliau pateikiami bei detalizuojami pagrindiniai grafinės aplinkos elementai (skydeliai, meniu,

langai ir t.t.) bei trumpai aprašomos pagrindinės jų savybės, darbo su jais ypatumai.

Taipogi yra skyrelis apie bylų sistemas Linux aplinkoje.

Perskaitę turėtumėte suprasti, kad dirbti su Linux išties yra nesudėtinga ir labai patogu.

2 Pagrindiniai įgūdžiai

2.1 Darbas pele

Šioje  instrukcijoje  kalbama  apie  dešiniarankiams  skirtą  pelę,  su  trimis  klavišais.  Ratuko,

esančio tarp dviejų klavišų arba abiejų klavišų paspaudimas vienu metu atitinka vidurinio pelės

klavišo paspaudimą.

Jei  esate  kairiarankis,  galima  sukeisti  pelės  klavišus.  GNOME  terpėje1

Programos→Darbalaukio  parinktys→Pelė  (Applications→Desktop  Preferences→Mouse),  o

KDE terpėje  Parinktys→Periferija→Pelė. 

1 lentelėje aprašyti veiksmai, atliekami kiekvienu pelės klavišu

1 lentelė

Pelės klavišas Aprašymas juo atliekamų veiksmų

Kairysis klavišas Naudojamas:
• pažymėti tekstą
• pasirinkti elementus (items)
• tempti elementus

Vidurinysis klavišas • įdėti tekstą
• perkelti elementus

Dešinysis klavišas Atidaro pasirinkto objekto meniu, jei toks meniu egzistuoja. Juo taip
pat  galima  tempti  įvairius  objektus,  o  nutempus  dažniausiai
parodomas papildomas meniu, kuriame galite išsirinkti veiksmą.

Pavyzdžiui, norėdami nukopijuoti tekstą atlikite tokius veiksmus:

1. Pažymėkite tekstą kairiu klavišu.

2. Pelės žymeklį nuveskite į vietą, į kurią norite įdėti nukopijuotą tekstą.

3. Paspauskite vidurinį pelės klavišą.

1 Žodžiai grafinė aplinka ir grafinė terpė naudojami kaip sinonimai.
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2 lentelėje pateikiami pagrindiniai veiksmų, atliekamų pele, terminai.

2 lentelė

Veiksmas Aprašymas

Spragtelėti (Click) Spustelti ir atleisti kairį pelės klavišą nepajudinant pelės

Laikyti  nuspaudus  (Click
and hold)

Nuspausti ir neatleisti kairiojo pelės klavišo

Spragtelėti  kairiu  klavišu
(Left – click)

Taip pat kaip ir spragtelėjimas. Terminas  Spragtelėjimas kairiu
klavišu naudojamas,  kai  yra  galimybė  supainioti  su
spragtelėjimas dešiniu klavišu.

Spragtelėti  viduriniu
klavišu (Middle – click) 

Spustelti ir atleisti vidurinįjį pelės klavišą nepajudinant pelės

Spragtelėti  dešiniu  klavišu
(Right – click)

Spustelti ir atleisti dešinįjį pelės klavišą nepajudinant pelės

Dvigumas  spragtelėjimas
(Double – click) 

Greitai  du  kartus  spustelti  ir  atleisti  kairįjį  pelės  klavišą
nepajudinant pelės

Tempti (Drag) Laikyti nuspaudus pelės klavišą, tada perkelti objektą į norimą
vietą. Pvz.: galima temti langą arba  ikoną. Šį veiksmą gali atlikti
kairysis ir vidurinysis klavišai. 

Tempti  ir  paleisti  (Drag
and drop)

Laikyti nuspaudus pelės klavišą, tada perkelti objektą į norimą
vietą. Pvz.: galima temti langą arba ikoną. Atleiskite pelės klavišą
norimoje vietoje.

Nutverti (Grab) Nutaikykite pelės  žymeklį  į  objektą,  kurį  galite perkelti.  Tada
laikykite nuspaudę kairįjį pelės klavišą. Pvz., galima nutverti už
lango pavadinimo juostos ir tempti langą į naują vietą.

Naudojantis pele turbūt pastebėjote, kad jos žymeklio išvaizda priklausomai nuo atliekamos

užduoties,  vietos ar būsenos gali keistis. 3 lentelėje pateikiamos galimos pelės žymeklio formos

bei jų aprašymai naudojami GNOME terpėje. KDE terpėje yra mažiau pelės žymeklio formų,

skliaustuose bus pateikiami tam tikri paaiškinimai apie KDE naudojamas pelės formas.

3 lentelė

Žymeklis Susijęs veiksmas Aprašymas

Nutaikyti  į  objektą,
pasirinkti meniu punktą

Normalus žymeklis. Toks jis būna paprastai naudojantis
pele.

Tempti ir paleisti Perkėlimo žymeklis. Nurodo, kad atleidus pelės klavišą
objektas yra  perkeliamas  iš senos vietos į naują.  (KDE
terpėje  ir  perkeliant  objektus  pelės  žymeklis  išlieka
nepakitęs)

Tempti ir paleisti Kopijavimo  žymeklis.  Nurodo,  kad  atleidus  pelės
klavišą toje vietoje sukuriama objekto kopija. 
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Žymeklis Susijęs veiksmas Aprašymas

Tempti ir paleisti Nuorodos žymeklis. Nurodo, kad atleidus pelės klavišą
toje vietoje sukuriama nuoroda į objektą. (GNOME) 

Tempti ir paleisti Pasirinkimo  žymeklis.  Nurodo,  kad  atleidus  pelės
klavišą atsidaro meniu, kurioje galite pasirinkti perkelti,
kopijuoti objektą ar sukurti į jį nuorodą. (GNOME)

Tempti ir paleisti Nesantis  žymeklis.  Nurodo,  kad  toje  vietoje negalima
paleisti objekto.

Perkelti objektą Objekto perkėlimo žymeklis.  Nurodo,  kad  pasirinkote
objektą perkėlimui. 

Keisti lango plotį Pločio keitimo žymeklis. Nurodo, kad jūs nuspaudę kairį
pelės klavišą pakeisite lango plotį.

Keisti lango aukštį Aukščio  keitimo žymeklis.  Nurodo,  kad  jūs  nuspaudę
kairį pelės klavišą pakeisite lango aukštį.

Keisti lango dydį Kampinio keitimo žymeklis. Nurodo, kad jūs nuspaudę
kairį pelės klavišą pakeisite lango dydį.

Keisti  lango  sričių  ar
lentelės skilčių dydį

Lango  sričių  ar  lentelės  skilčių  dydžio  keitimo
žymeklis.  Nurodo,  kad  pasirinkote  stulpelį,  kurio
pakeisite  dydį.  (atitinkamai  pasviręs  t.y.  rodyklės
horizontaliai, vertikaliai ar kampu KDE terpėje nurodo ir
lango dydžio keitimą).

2.2 Darbas klaviatūra 

Šiame skyrelyje pateikiama informacija kaip dirbti klaviatūra grafinėje terpėje. Kone visoms

operacijoms, atliekamoms su pele, galima naudoti klaviatūrą. Tam naudojami taip vadinamieji

spartieji klavišai (shortcut keys), tai įvairios klavišų kombinacijos, kurios padeda greitai atlikti

įvairias užduotis.

Visus  naudojamus  sparčiuosius  klavišus  GNOME  terpėje  galite  peržiūrėti  Programos  →

Darbalaukio parinktys → Klavišų susiejimai (Applications → Desktop Preferences → Keubord

Shortcuts), o KDE terpėje Parinktys → Išvaizda → Spartieji klavišai.

4  ir  5 lentelėse pateiksime kai kuriuos svarbius sparčiuosius klavišus.  4 lentelėje pateikiami

bendram darbui naudojami greitieji klavišai.

4 lentelė

Spartieji klavišai Funkcijos

Alt - F1 Atidaro  GNOME  ar  KDE  meniu.  Per  meniu  galima  vaikščioti
valdymo klavišų (rodyklių) pagalba.

Esc Uždaro atidarytą meniu

5



Spartieji klavišai Funkcijos

Alt - F2 Pasirodo programų paleidimo langas

Print Screen (GNOME)

Ctrl-Print  Screen
(KDE)

Padaroma esamo ekrano nuotrauka

Alt – Print Screen Padaroma aktyvaus lango nuotrauka

Ctrl – Alt - d Paslepiami visi atidaryti langai, kad liktų tuščias darbastalis

Alt - Tab Pereiti per atidarytus  langus.  Pasirinkus norimą langą  (spaudinėjant
Tab neatleidus Alt) atleiskite abu klavišus.

Ctrl  -  Alt  -
Backspace

Išėjimas  iš  grafinės  aplinkos.  Naudokite  jei  nežinote  kaip  išeiti  iš
kažkokios programos t.y. negalite normaliai dirbti toliau. Nepamirškte,
kad  prarasite  visą  neišsaugotą  informaciją  programose,  kurios  buvo
paleistos tuo metu.

Sparčiųjų klavišų naudojimas programose leidžia atlikti daugelį užduočių greičiau nei dirbant

pele. 5 lentelėje pateikiami pagrindiniai programose naudojami spartieji klavišai.

5 lentelė

Spartieji klavišai Komanda

Ctrl – n Naujas

Ctrl – x Iškirpti

Ctrl - c Kopijuoti

Ctrl - v Įdėti

Ctrl - z Atšaukti

Ctrl - s Išsaugoti

Ctrl - q Baigti

Visas klavišų kombinacijas galima pamatyti atsidarius bet kurios programos meniu. Prie kai

kurių punktų pateikiamos galimos kombinacijos.  Pvz.: nueikite į  kokios nors  programos  Byla

(File)  meniu  punktą  ir  prie  meniu  punkto  rasite  kai  kuriuos  lentelėje  pateiktus  sparčiuosius

klavišus. 

Yra dar vienas būtas greitai dirbti klaviatūra. Galbūt pastebėjote, kad daugelyje programų tam

tikros meniu arba pasirodančių pranešimų raidės būna pabrauktos. Tai reiškia, kad spausdami Alt

ir  tame žodyje pabrauktą  raidę  atversite parašytą  meniu punktą ar  įvykdysite komandą.  Pvz.

Meniu punkte File (Byla) yra pabraukta raidė “F”, taigi paspaudus Alt - F atsidarys File meniu, o

paspaudus raidę N, kuri yra pabraukta žodyje New (Naujas)  sukursite naują bylą ar atidarysite

naują  programos langą. Taip pat,  per meniu punktus galite vaikščioti rodyklių pagalba  arba  ir

toliau naudotis pabrauktomis raidėmis + Alt). Vartotojo patogumai visada siūloma daug įvairių

būdų tam tikrai užduočiai atlikti.
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Taipogi darbui su langais galima naudoti ir kitus klavišus (6 lentelė).

6 lentelė

Klavišai Funkcijos

Tab Galima vaikščioti tarp lango ar dialogo elementų

Valdymo  (rodyklių)
klavišai

Juos naudojant galima atlikti šias užduotis:
• Meniu juostoje vaikščioti tarp atskirų meniu. Atidarytoje meniu,

vaikščioti tarp meniu punktų.
• Vaikščioti tarp parinkčių.
• Keisti skaitiklio reikšmes.
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3 Darbo su Linux OS pradžia bei pabaiga

Paspaudus  kompiuterio  įjungimo mygtuką  reikia  šiek tiek palaukti,  kol  pasirodys  pradinis

prisijungimo ekranas, kuriame OS Linux vartotojas turės užsiregistruoti – t.y. įvesti prisijungimo

vardą bei slaptažodį. Į registravimosi programą taip pat patenkate kai baigiate darbą grafinėje

aplinkoje (paspaudžiate mygtuką „Atsijungti“ („Išsiregistruoti“) arba vienu metu paspaudžiate

klavišus Ctrl - Alt - Backspace).

1 pav. matote GNOME registravimosi programą (pasirinkta “Circles” grafinė išvaizda).

Įprastas  KDE registracijos  langas  pateiktas  2 paveiksle.  Viršuje  parašyta  sistemos vardas,

langelyje pavaizduotos sistemoje esančių vartotojų ikonos bei parašyti jų prisijungimo vardai.

Žemiau  reikia  įvesti  vartotojo  prisijungimo  vardą (Login)  arba  galima  tiesiog  du  kartus

spragtelėti ant  jus  vaizduojančios  ikonos;  tuomet galima  įrašyti  slaptažodį (Password);  ir  jei

norite - pasikeisti sesiją (Session Type) t.y. kiekvieną kartą prisijungdamas  jūs galite pasirinkti

kokioje grafinėje aplinkoje dirbsite – KDE, GNOME, IceWM, Windowmaker ir t.t.
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Apačioje esantys mygtukai reiškia:

• Eiti (Go). Paspaudus Eiti (Go) mygtuką patvirtinsite registraciją; 

• Išvalyti (Clear). Ištrina įrašytas reikšmes.

• Išjungti  (Shutdown).  Parodomas  dialogas,  kuriame  galima  pasirinkti išjungti  ar  perkrauti

kompiuterį. GNOME prisijungimo programoje jį rasite meniu „Sistema“ (System).

• Kalba (Language).  Šis mygtukas  yra  tik GNOME prisijungimo programoje.  Jį paspaudus

atsiras dialogas, kuriame galėsite pasirinkti grafinės aplinkos kalbą.

Visada  tvarkingai  išjunkite  kompiuterį  registravimosi  programoje  išsirinkdami  atitinkamą

komandą ir niekada iškart nespauskite kompiuterio korpuse esančio išjungimo mygtuko !!!

Jei nežinote kaip grįžti į  registravimosi programą  (pavyzdžiui jums  pakibo programa,  kuri

užima visą kompiuterio ekraną ar jūs nežinote kaip iš jos išeiti ) - vienu metu paspauskite klavišus

Ctrl - Alt - Backspace – šios kombinacijos pagalba išeisite iš grafinės aplinkos ir tada iš naujo

pasileis registravimimosi programa. Nepamirškte, kad paspaudę šią klavišų kombinaciją prarasite

visą neišsaugotą informaciją programose, kurios buvo paleistos tuo metu !!!
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4 Grafinės aplinkos apžvalga

Šiame  skyrelyje  apžvelgsime  pagrindinius  grafinės  aplinkos  komponentus,  pateikiant  jų

savybes bei pagrindinių komponentų veikimo būdus. 

Pirmiausia pateiksime GNOME ir KDE grafinių aplinkų ekrano nuotraukas.
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Pagrindiniai grafinės aplinkos komponentai yra šie:

• Skydeliai (panels)

Tai  juostos  darbalaukyje,  iš  kurių  galima  pasiekti  visas  sistemos  programas  bei  meniu.

Skydeliai yra lengvai konfigūruojami. Ypač  svarbus yra meniu skydelis (GNOME grafinėje

aplinkoje),  kuris  gerai  matosi  3 paveiksle.  .Meniu  skydelis  yra  ištisinė  juosta  darbastalio

viršuje. Jame yra du meniu: 

• programų meniu (Applications), kuriame yra visos programos, konfigūracijos įrankiai,

bylų tvarkyklė bei pagalbos naršyklė; 

• veiksmų meniu (Actions), kurioje yra įvairios komandos (veiksmai), pvz.: bylų paieška

(Search for File) ar atsijungimas (Log Out).

KDE aplinkoje standartiškai yra tik apatinis skydelis, vadinamas pultu. 

• Meniu (Menus)

Visos  kompiuterio  funkcijos  yra  prieinamos  per  meniu.  Meniu  skydelyje  yra  meniu,  taigi

atliekant  įvairias  užduotis  galima  kartu  naudotis  skydeliais  bei meniu.  GNOME aplinkoje

naudojantis  programų  bei  veiksmų meniu  galima  pasiekti  beveik visas  sistemoje  esančias

programas, komandas, konfigūravimo parinktis.

Taipogi visus elementus galima rasti GNOME ar KDE meniu.
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• Langai (Windows)

Vienu  metu  galima  dirbti  su  daug  langų.  Kiekviename  lange  galima  pasileisti  skirtingas

programas.  Visi  langai  turi  rėmus  bei  mygtukus.  Su  langais  galima  atlikti  standartinius

veiksmus - perkelti, uždaryti, pakeisti lango dydį.

• Darbo erdvės (Workspaces)

Programas,  kuriomis dirbate, galima sudėlioti į atskiras darbo erdves. Galima susikurti kiek

norima darbo erdvių, tarp kurių yra paprasta vaikščioti. Tačiau vienu metu ekrane matoma tik

viena darbo erdvė.

• Bylų tvarkyklė (File manager)

Su juo galima patogiai tvarkyti ir peržiūrėti turimas bylas bei programas.  Tvarkyklės lange

galima  peržiūrėti  bylų  turinį  arba  atverti  bylą  panaudojant  tinkamą  programą.  Su  bylų

tvarkykles galima peržiūrėti bei tvarkyti ir savo kompiuteryje ir tinkle ar  internete esančias

bylas.

• Darbalaukio fonas (Desktop background)

Darbalaukio fonas yra aktyvus komponentas – jame galima patalpinti objektus, padedančius

greitai pasiekti norimas bylas ar  katalogus,  arba padėti dažnai vartojamas  programas.  Fone

paspaudus dešinį pelės klavišą yra iškviečiamas specialus meniu, kurio pagalba galėsite atlikti

daug veiksmų su bylomis bei darbalaukio fonu.

• Darbalaukio parinktys (Desktop preferencies)

GNOME ir KDE grafinėse aplinkose yra nesudėtinga tvarkyti, prižiūrėti bei sau prisitaikyti visą

sistemą.  Įvairius  parinkčių  įrankius  GNOME  aplinkoje  rasite  Programos  →  Darbalaukio

parinktys  (Applications  →  Desktop  Preferences),  KDE  aplinkoje  Parinktys.  Iš  meniu

pasirinkite elementą, kurį norite sukonfigūruoti. 

Svarbu,  kad  dirbti grafinėse  aplinkose  yra  paprasta,  nes  įvairūs  komponentai  puikiai  dera

tarpusavyje. Be to, daugelį operacijų galima atlikti įvairiais būdais. Pavyzdžiui, programą galima

paleisti iš skydelio, iš meniu ar iš darbastalio.

Kituose  skyreliuose  detaliau  aprašysime  visus  komponentus,  darbo  su  jais  ypatumus,

galimybes. Kad būtų lengviau suprasti pateiksime daug įvairių elementų piešinių.

4.1 Skydeliai (Panels)

Skydelius galima pridėti ar  pašalinti bet kuriuo metu. Pirmą kartą paleidus grafinę GNOME

aplinką paprastai matosi du skydeliai:

• Meniu skydelis
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• Apatinis skydelis

KDE aplinkoje įprastai yra vienas skydelis apačioje, jis vadinamas pultu. 

KDE pulto  konfigūravimas  yra  panašus  kaip ir  GNOME skydelių.  Bet kurioje tuščioje jo

vietoje  paspaudę dešinį klavišą išsikviesite meniu, kurioje galite pasirinkti objektus, kuriuos galite

pridėti į pultą arba išmesti iš jo, keisti paties pulto nuostatas bei dydį. Pulto objektai taipogi yra

panašūs  į  GNOME skydelių objektus.  Taigi kalbant  apie  veiksmus,  kuriuos galima  atlikti su

skydeliais remsimės GNOME aplinkos pavyzdžiais.

Su skydeliais galima atlikti tokius veiksmus:

• Sukurti skydelius 

1. Paspauskite dešinį pelės klavišą tuščioje bet kurio esančio skydelio vietoje ir pasirinkite

Naujas skydelis (New Panel)

2. Iš atsiradusios miniu pasirinkite norimą skydelio tipą. Skydelis pridėtas.

Galima sukurti tiek skydelių kiek tik norite, pagal savo poreikius galima keisti skydelių elgesį

ar išvaizdą, pvz. galima pakeisti skydelio foną.

• Pašalinti skydelius

Paspaudę dešinį pelės klavišą ant skydelio, išsirinkite Pašalinti šį skydelį (Delete This Panel).

• Paslėpti skydelius

Visi skydeliai, išskyrus Meniu skydelį galuose turi paslėpimo mygtukus (mygtukas su rodykle).

Paspaudus  jį  galima  paslėpti  arba  vėl  ištraukti  skydelį.  Paveiksle  pateikiama  paslėpimo

mygtukai.

• Įdėti objektus į skydelius 

Į skydelius dedamų objektų pavyzdžiai parodyti 9 paveiksle.
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Į skydelį galima įdėti įvairius objektus:

➔ Leistukus (Launchers), jų pagalba galima paleisti tam tikrą programą, įvykdyti komandą

ar atidaryti bylą. Galima patiems sukurti leistukus dažnai naudojamoms programoms

(pvz.: tekstų redaktoriui).

Norint įdėti naują  leistuką,  reikia  tuščioje skydelio vietoje paspausti  dešinį pelės klavišą ir

išsirinti Pridėti → Leistuką (Add to Panel → Launcher),  Pridėti → Leistuką iš meniu (Add to

Panel → Launcher from menu) ir iš meniu išsirinkti norimą programą.

➔ Meniu (Menus), 

Visas reikalingas funkcijas galima pasiekti per meniu. Įprastuose skydeliuose yra meniu, taigi

atlikdami įvairias užduotis galite naudotis tiek meniu, tiek skydelyje esančiais objektais. 

Skydelyje meniu vaizduojama kaip ikona su rodykle (žr. 9 paveiksle). 

➔ Įtaisus (Appletts) – tai mažos, interaktyvios programėlės esančios skydeliuose, pvz. CD

grotuvas. Kiekvieną programėlę paprasta valdyti pele ar klaviatūra. Įprastai skydelyje

būna šie įtaisai:

• Langų  sąrašas  (Window  List).  Rodomi  visi  tuo  metu  atidaryti  jūsų  sistemos  langai.

Pateikiamas mygtukas kiekvienam atidarytam langui. Paspaudus ant lango sąrašo mygtuko

galima langą paslėpti ar atstatyti jo dydį. Įprastai langų sąrašas būna apatiniame skydelyje. 

• Darbo erdvių keitiklis (Workspace Switcher). Juo naudojantis galite pereiti iš vienos erdvės į

kitą. Įprastai darbo erdvių keitiklis yra apatiniame skydelyje.

Norint įdėti naują įtaisą į skydelį reikia paspausti dešinį klavišą tuščioje skydelio vietoje ir iš

meniu  išsirinkti  Pridėti  (Add  to  Panel),  o  įtaisus  galima  pasirinkite  iš  kurios  nors  meniu

kategorijos:  priemonės  (Accessories),  pramogos  (Amusements),  Internet,  Multimedia,  Utility.

Pavyzdyje (10 paveiksle) pateikiama langų sąrašo, CD grotuvo bei garso kontrolės įtaisai.

➔ Stalčius (Drawers)

Tai  slankiojantys  skydelio  išplėtimai,  kuriuos  galima  atidaryti  ir  uždaryti.  Jie padeda  kai
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dirbama  su  daug  programų  vienu  metu.  Į  stalčių  galima  sudėti  visus  panašių

funkcijų elementus. 

Norint  pridėti  stalčių,  reikia  tuščioje  skydelio  vietoje  paspausti  dešinį  pelės

klavišą ir išsirinti Pridėti → Stalčių (Add to Panel → Drawer).

Atidaryto stalčiaus pavyzdys, kuriame yra du objektai parodytas 11 paveiksle. 

Į stalčių galima įdėti, išmesti, perkelti objektus taip pat kaip ir į skydelį.

➔ Kitus skydelio objektus (Other Panel Objects). 

Kai kurie skydelio objektai atlieka tam tikras specifines funkcijas, pvz. užrakinimo mygtukas

(Lock Button) (12 paveikslas) užrakina ekraną, išsiregistravimo mygtukas (Log Out Button) (13

paveikslas) pradeda išsiregistravimo iš esamos sesijos (grafinės aplinkos) procesą.

Šiuos skydelio objektus galima rasti paspaudus dešinį klavišą tuščioje skydelio vietoje iš meniu

išsirinkus Add to Panel.

• skydelio objektų valdymas

Paspaudus dešinįjį klavišą ant kiekvieno skydelio objekto atsiranda meniu, kurioje yra įvairios

komandos (14 paveikslas)  - savybės (Properties), pagalba (Help), išmesti iš skydelio (Remove

from Panel), perkelti (Move). 

Galima kilnoti objektus iš vienos vietos į kitą pačiame skydelyje ar  iš vieno skydelio į kitą.

Objektų perkėlimui naudokite vidurinįjį pelės klavišą. Taipogi galima kopijuoti meniu elementus į

skydelį. Paprasčiausiai bandykite tempti norimas programas iš meniu į skydelį. 

4.2 Meniu

Beveik kompiuterio funkcijas galima pasiekti per meniu. 

GNOME aplinkos svarbiausi meniu yra:

• Programų meniu (Applications menu). Joje galima rasti daugelį sistemos programų, komandų

bei sistemos konfigūravimo parinkčių.
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• Veiksmų meniu  (Actions  menu)  Galima  pasiekti  įvairias   komandas,  pvz.  galima  paleisti

programų paieškos įrankį arba užrakinti ekraną.

Programų bei Veiksmų meniu būna meniu skydelyje (viršuje). 

• GNOME meniu – visus Programų bei Veiksmų meniu punktus galima pasiekti per šį meniu. Į

skydelį galima įsidėti GNOME meniu ikoną (15 paveikslas). 

KDE aplinkoje paprastai būna vienas meniu (16 paveikslas) pulto kairiame kampe.

17 ir 18 paveiksluose parodyta kaip atrodo išskleistos pagrindinės grafinių aplinkų meniu.

Rodyklės, esančios dešinėje pusėje prie kai kurių meniu punktų parodo, kad tai yra tam tikra

meniu elementų grupė. 

GNOME meniu programos  yra  sutrauktos  meniu punkte Programos  (Applications),  o  kiti

meniu punktai gali būti rasti ir Veiksmų (Actions) meniu.  KDE meniu iš karto yra labai  plati,

nemažai programų yra pateikiamos tiesiogiai pačiame meniu. 

Naudodamiesi meniu galite atlikti įvairias užduotis, pvz. pasileisti norimą programą, padaryti

ekrano nuotrauką (Screenshot), rasti bylas (search for files) ir t.t. 

Paspaudus dešinį klavišą darbalaukio fone atsidaro Darbalaukio meniu (Desktop Background

menu), jame galima rasti įvairias su darbastaliu susijusias komandas – sukurti nuorodą į bylą,

programą, dirbti su bylomis, greitai paleisti tam tikras programas,  įvykdyti komandas,  prijungti
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diskus prie katalogų (GNOME aplinkoje, apie tai plačiau rašysime 4.6.3 skyriuje). 

Taigi išsikviesti meniu galite iš skydelių arba naudojantis sparčiaisiais klavišais. 

4.3 Langai 

Vienu metu galima dirbti su daug langų. Kiekvienas langas turi rėmelį, kuriame yra aktyvūs

darbo su langu elementai.

Langai būna dviejų rūšių:

• Programų langais (Application windows)

Paleidus programą paprastai ji atsidaro lange, kuris turi rėmelį. Viršuje yra pavadinimo juosta

(19 paveikslas), kurioje yra mygtukai, padedantys dirbti su langu. Rėmelio mygtukų pagalba

atliksite veiksmus, tokius kaip atidaryti lango meniu, paslėpti, uždaryti langą.

• Dialogų langai (Dialog windows)

Dialogų langai susiję su aktyviais kompiuterio procesais. Šiuose iššokančiuose languose yra

įvedama informacija  arba  komandos. Jie taipogi turi rėmelį, kurio mygtukų pagalba  galima

atidaryti lango meniu arba uždaryti dialogų langą.

Langai valdomi rėmelių pagalba. Dauguma kontrolės elementų yra viršutinėje rėmelio juostoje.

19 ir 20 paveiksluose pateikiama įprasta langų rėmelio pavadinimo juosta.

 

Aktyvūs lango kontrolės elementai pateikti 7 lentelėje.

7 lentelė

Kontrolės elementas Aprašymas

Lango  meniu  mygtukas  (Window
menu button)

Spragtelėjus jį atsidaro lango meniu

Pavadinimo juosta (Titlebar) Nutvėrus už šios juostos galima perkelti langą
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Kontrolės elementas Aprašymas

Sumažinimo (Minimize) mygtukas Jį paspaudus langas pasislepia

Padidinimo (Maximize) mygtukas Spaudžiant  šį  mygtuką galima  langą  išskleisti  per  visą
ekraną, dar kartą paspaudus šį mygtuką atsistatys prieš tai
buvęs lango dydis

Lango uždarymo (Close) mygtukas Jį paspaudus uždaromas langas

Rėmelis (Border) Ant lango rėmelio paspaudus dešinį klavišą iškviečiamas
lango meniu

Norint  pakeisti  lango dydį  čiupkite už rėmelio,  išskyrus  pavadinimo juostą,  ir  temkite iki

norimo dydžio.

Lango meniu pateikiamos lango valdymo komandos (21, 22 paveikslai).

Kai kurių meniu punktų reikšmės pateikiamos 8 lentelėje.

8 lentelė

Meniu punktas Funkcija

Uždaryti (Close) Uždaro langą

Sutraukti (Minimize) Sutraukia (paslepia) langą

Išdidinti (Maximize) Išdidina langą. Jei langas paspaudus šį mygtuką bus atstatytas
prieš tai buvęs lango dydis

Perkelti (Move) Leidžia perkelti langą į kitą vietą

Į  darbastalį  (arba  darbo
erdves) (Move to workspace)

Perkelia langą į kurią nors (pagal numerį) darbo erdvę (KDE
vadinamą  darbalaukiais).  Pasirinkus  į  visus  darbastalius  arba
visas  darbo  erdves  (Put  on  All  workspaces)  tas  langas  bus
įkeltas į visas esamas darbo erdves.

Vienu metu  gali  būti  aktyvus  tik vienas  langas.  Aktyvaus  lango  pavadinimo  juosta  būna

ryškesnė.
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• Jei langas matosi galima spragtelti ant jo pele. 

• Tarp  atidarytų  langų  galima  vaikščioti greitųjų  klavišų  pagalba  (įprasta  kombinacija  Alt-

Tab).

• Spragtelėjus ant to lango langų sąraše.

• Darbo erdvės keitiklyje spragtelėkite ant lango, kurį norite padaryti aktyviu.

Dirbant su langais yra svarbu plačiau aptarti langų sąrašo įtaiso (Window List Applet) (KDE

aplinkoje jis vadinamas  užduočių juosta) reikšmę bei funkcijas. Jame pateikiami visų atidarytų

langų  mygtukai.  Naudojantis  šiuo  įtaisu  taipogi  galima  atlikti  kai  kuriuos  langų  valdymo

veiksmus:

• Sumažinti (Minimize) langą;

Spragtelėkite ant langą vaizduojančio mygtuko

• Atstatyti (Restore) sumažintą langą;

Spragtelėkite ant langą vaizduojančio mygtuko

• Padaryti langą aktyviu (Give focus to Window)

Spragtelėkite ant langą vaizduojančio mygtuko

Atidarius langą, automatiškai Langų sąraše atsiranda naujas to lango mygtukas. Šiame sąraše

matosi visi atidaryti langai, net jei kai kurie langai yra sumažinti ar ant jų viršaus atidaryti kiti

langai.  Langų sąraše  gali  matytis esamos  darbo erdvės (darbalaukio) langai  arba  visų erdvių

langai.  Šią  ir  kitas  parinktis  galite  pakeisti  Langų  sąrašo  (užduočių  juostos)  nuostatose

(Preferencies), kurios yra įtaiso meniu (meniu rasite spragtelėję dešinį klavišą ant langų sąrašo

ženkliuko . Taipogi ženkliukas matosi ir 23 paveiksle.

Ant  langų  mygtukų  paspaudę  dešinį  klavišą  iškviesite  lango  meniu  (be  darbo  erdvių

komandų).

23 paveiksle yra langų sąrašo pavyzdys kai languose atidarytos tokios programos :

• gedit

• Dictionary

• Ghex

• GNOME terminal

Mygtukai taipogi parodo ir langų būsenas. 9 lentelėje pateikiami 23 paveikslo pavyzdžio langų
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informacijos išaiškinimai.

9 lentelė

Būsena Tai reiškia Pavyzdys

Mygtukas įspaustas Langas yra aktyvus gedit

Lango  pavadinimas  laužtiniuose
skliaustuose []

Langas  yra  sumažintas
(minimized)

[Dictionary]

Mygtukas  nei  įspaustas,  nei
skliaustuose

Langas rodomas ekrane ir
nėra sumažintas

ghex

Ant mygtuko skaičius skliaustuose Mygtukas  vaizduoja
mygtukų grupę

Gnome-terminal (3)

KDE  aplinkoje  jei  langas  sumažintas  mygtukas  rodomas  labai  neryškiai,  jei  mygtukas

vaizduoja mygtukų grupę  ant jo atsiranda rodyklytė (paveikslas 24).

Taigi Langų sąrašo  įtaisas  leidžia  sugrupuoti tos pačios  grupės langus  (pvz. kelis  Mozilla

naršyklės langus, kelis Open Office dokumentus). Langų sąrašo nuostatose galite nurodyti kada

norite tai daryti (kai yra labai daug langų atidaryta, visada arba niekada). 

Paspaudus ant grupės mygtuko pasirodo visi langai, tada galima išsirinkti jums reikimą langą.

25 ir 26 paveiksluose pateikiami išskleistų langų grupės mygtukų pavyzdžiai.

4.4 Darbo erdvės (Workspaces)

Vienu metu galima atsidaryti daugybę langų, o kad būtų patogiau su jais dirbti galima juos
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sudėlioti  į  atskiras  darbo  erdves,  dar  vadinamas  virtualiais  darbalaukiais  arba  darbastaliais2

(virtual desktops). Kiekvienos darbo erdvės yra  tie patys skydeliai bei tas  pats  meniu. Tačiau

kiekvienoje erdvėje galite paleisti skirtingas programas ar atsidaryti skirtingus langus.

Jos leidžia geriau organizuoti savo darbą, kai dirbama su daug programų (daug langų). Kai jūsų

darbo erdvė perpildoma  įvairiausiais  langais,  galite tiesiog pereiti dirbti į  kitą erdvę. Žinoma

galima iš karto tam tikras  programas  paleisti skirtingose darbo erdvėse (pvz. paleidus vaizdų

apdorojimo programą GIMP iš karto atidaromi bent penki langai, tad labai patogu tokią programą

atsidaryti antroje darbo erdvėje). Darbo erdvės matomos darbo  erdvių keitiklyje (Work space

switcher). Paprastai šis įtaisas (Applet) būna apatiniame skydelyje, bet jį galima įsidėti į bet kurį

skydelį.  27 paveiksle pateiktame darbo erdvių keitiklyje matyti keturios darbo erdvės. Pirmose

trijose erdvėse yra atidarytų langų. Paskutinė erdvėje nėra atidarytų langų. Darbo erdvės yra tarsi

mygtukai, tarp jų paprasta vaikščioti naudojantis pele. Erdvės, kurioje šiuo metu esate, fonas yra

paryškintas. 

Junginėti darbo erdves galima šiais būdais:

• Darbo erdvių keitiklyje spragtelėkite ant norimos erdvėse

• Naudojantis greitaisiais klavišais  Ctrl-Alt-dešinioji rodyklė(→) perjungia į dešinėje pusėje

esančią erdve, o Ctrl-Alt-kairioji rodyklė(←) į kairėje esančią darbo erdvę.

Naujų erdvių galite įsidėti nuspaudę dešinį pelės klavišą ant darbo erdvių keitiklio ir iš meniu

išsirinkę nuostatos (Preferences), tenai esančiame laukelyje galite įrašyti norimą erdvių skaičių.

Norėdami sumažinti erdvių skaičių, laukelyje įrašykite mažesnį skaičių. Iš panaikinamų darbo

erdvių langai bus perkelti į likusias, naikinasi erdvės iš dešinės į kairę.

KDE  aplinkoje  darbo  erdvės  yra  vadinamos  tiesiog  darbastaliais.  Apatiniame  skydelyje

pateikiama esamų darbastalių valdymo priedas, esantis KDE pulte (paveikslas 28).

Ant darbastalių schemos paspaudus dešinį klavišą, galima keisti schemos nuostatas, tai pat įdėti

naujų darbastalių. Galima įjungti darbastalio peržiūrą vadinamą Darbastalio puslapiuotoju., kuris

atsidaro  paspaudus  ant  dešinėje pusėje esančios rodyklės. Jame vaizdžiai matosi kokie langai

kurioje darbo erdvėje atidaryti (paveikslas 29).

2 Darbastalis yra tas pats kas ir darbalaukis. Angliškai abu žodžiai verčiami desktop.
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4.5 Linux bylų sistema

Dirbant su Linux labai svarbu suprasti, kas yra ta bylų sistema (Filesystem), kadangi šioje OS

yra  griežta  bylų sistemos hierarchija,  o vartotojas  savo bylas  gali  laikyti dažniausiai  tik jam

skirtame kataloge, dar vadinamam vartotojo asmeniniu (namų) katalogu.

Linux OS yra vienas pagrindinis, dar vadinimas šakniniu  (root) katalogas,  kuris žymimas /

(pasvirusiu brūkšniu) ir jame yra visi kiti katalogai (Folders) bei bylos (Files). Katalogų struktūra

dažniausiai  atvaizduojama  apversto  medžio pavidalu.  30 paveiksle  pateiktas  katalogų  medis,

kuriame matyti šakninis katalogas ir jame esantys katalogai bei bylos. Linux'e bylos būna dviejų

tipų – paprastos  bylos  bei nuorodos į  bylas  ar  katalogus.  Nuorodos irgi būna  dviejų rūšių –

„simbolinės“  (symbolic  link)  ir  „kietosios“  (hard  link).  Pastarosios  reikalingos  tik  labai

patyrusiems vartotojams. Simbolinė nuoroda – tai tam tikros rūšies byla, nurodanti į kitą bylą ar

katalogą. Kai jūs atliekate tam tikrą  veiksmą su nuoroda, iš tiesų jūs atliekate tą veiksmą su byla

ar  katalogu,  su  kuriuo  ji  susijusi.  Tačiau  ištrindami  arba  pervadindami  nuorodą,  ištrinate  ar

pervadinate tik ją, bet ne bylą ar katalogą, į kurią ji nurodo.
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Daugelyje katalogų yra saugomos sisteminės bylos ir jas keisti gali tik administratoriaus teises

turintis vartotojas. Kai kurių katalogų paskirtis aprašyta 10 lentelėje.

10 lentelė

Katalogas Paskirtis (aprašymas)

/cdrom Prie jo  yra  prijungiamas  CD-ROM įrenginys  Jei  cdrom nėra  šakniniame

kataloge – ieškokite /mnt kataloge

/dev Labiau  patyrusiems  vartotojams  naudinga  žinoti,  kad  tai  yra  kompiuterio

įrenginių katalogas  (Linux OS kiekvienas  įrenginys yra  atitinkama  byla  /dev

kataloge). Šiame kataloge paprastas vartotojas negali nieko pakeisti ar rašyti.

/etc Tai  yra  konfigūracinis  katalogas,  kuriame  saugomos  OS  konfigūracinės

bylos. Šiame kataloge paprastas vartotojas negali nieko pakeisti ar rašyti.

/floppy Prie  jo  yra  prijungiamas  diskelių  įrenginys.  Jei  floppy nėra  šakniniame

kataloge – ieškokite /mnt kataloge.
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Katalogas Paskirtis (aprašymas)

/home Visa vartotojų informacija saugoma šiame kataloge. Jame yra visų sistemos

vartotojų  katalogai,  kuriuose  saugoma  visa  asmeninė  vartotojų  informacija

(dokumentai, muzika ir t.t.). Dažniausiai vartotojas laisvai gali tvarkytis tik su jo

asmeniniame (kitaip vadinamam vartotojo namų) kataloge, kuris dažniausiai yra

/home/jūsų_prisijungimo_vardas esančiomis bylomis, prie kitų bylų priėjimas

yra  uždraustas.  Tad  vartotojas  gali  drąsiai  jaustis,  nes  nieko  sugadinti  OS

sistemoje jis paprasčiau negali.

/mnt Jei /floppy, /cdrom katalogų nėra šakniniame kataloge, tada juos rasite /mnt

(mount – prijungti, primontuoti) kataloge. 

/tmp Šiame kataloge /tmp yra saugomos laikinosios bylos. Kiekvienas vartotojas

gali į šį katalogą rašyti ką nori, bet perkrovus sistemą šis katalogas  gali būti

automatiškai išvalytas.

/usr Šiame kataloge yra saugomos programos bei joms priklausantys duomenys,

dokumentacija ir t.t.

/usr/share/

pixmaps

Kataloge /usr/share/pixmaps ir jo pakatalogiuose yra saugoma labai  daug

įvairiausių paveikslėlių, kiekvienas  vartotojas  gali pasinaudoti tenai esančiais

paveikslėliais.

/usr/share/

doc

Kataloge  /usr/share/doc pateikta  visa  Linux  bei  esamų  programų

dokumentacija.

4.6 Bylų tvarkyklė (File Manager)

Tvarkyti savo katalogo bylas yra paprasčiausia dirbant su bylų tvarkyklėmis – GNOME terpėje

Nautilus, o KDE terpėje Konqueror. Abiejose terpėse darbo su bylomis principai yra tie patys.

Nueiti į savo namų (asmeninių bylų) /home/jūsų_vardas katalogą galima keliais būdais:

• programų  meniu  išsirinkti  namų  katalogas  (Applications→Home  Folder),  KDE  terpėje

pagrindiniame meniu yra punktas Pradžia (Asmeninės bylos)

• darbalaukyje visada  yra ikona GNOME terpėje ji vadinasi namai  (home),  o KDE terpėje –

pradžia. 

• galite į bet kurį skydelį įsidėti namų katalogo leistuką. KDE terpėje įprastai jis jau būna įdėtas

apatiniame skydelyje.

• Galima pirma atsidaryti bylų tvarkyklę, o tada nueiti į namų katalogą.

Abiejose terpėse  namų katalogas žymimas nameliu (paveikslai 31 ir 32).

24



• Rodyti bylas ir katalogus. Galite pasirinkti kaip peržiūrėti bylas (kaip ikonas ar sąrašą)

• Tvarkyti bylas ir katalogus (kurti naujas, perkelti, kopijuoti, keisti pavadinimus, išmesti)

• Paleisti skriptus (scripts)

• Personalizuoti (customize) bylas ir katalogus. Pvz. Nautilus programoje galite uždėti tam tikrą

emblemą ant bylų ar katalogų.

Toliau nagrinėsime bylų tvarkyklės komponentus.

GNOME terpės bylų tvarkyklės Nautilus pagrindiniai komponentai ir jų aprašymai pateikti 11

lentelėje.
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11 lentelė

Komponentai Aprašymas

Meniu  juosta
(Menubar)

Joje yra įvairių užduočių meniu

Mygtukų  juosta
(Toolbar)

Joje yra mygtukai naudojami dirbant su Nautilus

Adreso  juosta
(Location bar)

Joje yra šie elementai:
• Vietos laukelis arba Eiti į (Go To) laukelis, kuriame galite nurodyti kelią į

bylą ar katalogą ar URL adresą.
• Mastelio  mygtukai:  leidžia  keisti  rodomų  bylų  dydį  arba  sugrąžina  į

natūralų dydį.
• Rodyti kaip (View as ...) išsiskleidžiantis sąrašas: galite pasirinkti kaip bus

rodomi peržiūrimi elementai.

Šoninė  sritis
(Side pane)

Atlieka šias funkcijas:
• leidžia valdyti (navigate) jūsų bylas (galite peržiūrėti bylos turinį, pasirinkti

kokia programa tai padaryti)
• pateikia esamos bylos ar katalogo informaciją 

Kortelės  (Tabs) spragtelėjus  ant  kortelę  parodomas  jos  turinys.  Ant  kortelių  juostos
paspaudus dešinį klavišą galima pasirinkti kurias korteles norite matyti (uždėti
varnelę prie norimų matyti kortelių). Yra šios kortelės:
• Istorija  (History)  (pateikiama  istorija  aplankytų  bylų,  katalogų,  FTP

svetainių chronologine tvarka)
• Medis (Tree) (pateikiamas sistemos bylų medis , žr. 30 pav.)
• Užrašai (Notes) (galite ką nors užsirašyti) 

Vaizdo  sritis
(View pane)

Parodo turinį:
• Tam tikrų bylų (pvz. galite peržiūrėti PNG tipo paveikslėlius. Visgi bylų

redaguoti negalima,  tačiau  galima  atidaryti bylas  naudojant  atitinkamas
programas)

• Katalogų
• FTP svetainių

Konqueror bylų tvarkyklės komponentai yra panašūs kaip ir Nautilus, tačiau šiek tiek skiriasi.

Konqueror bylų tvarkyklė pateikta 34 paveiksle. Taigi galima matyti, kad daugelis komponetų

meniu, mygtukų, adreso juostos, vaizdo sritys yra panašios abiejose tvarkyklėse. 

Kairėje  pusėje  yra  navigacijos  pultas,  kuriame yra  daug įvairių ikonų. Palaikius pelę ties

kiekviena ikona ilgiau atsiranda užrašas, paaiškinantis kas ten yra. Kai kurių ikonų funkcijos yra

panašios kaip ir Nautilus kortelių.

33  ir 34 paveiksluose pateikta įprasti bylų tvarkyklių langų vaizdai. Yra daugybė  papildomų

galimybių (įvairūs papildomi skydeliai, meniu juostos ir t.t. - apie tai plačiau 4.6.5 skyrelyje).
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4.6.1 Bylų ir katalogų peržiūra

Vaizdo srityje bylos, katalogai gali būti rodomi:

• Piktogramų vaizdu (Icon view)3 (33 ir 34 paveiksluose būtent taip ir išdėstyti elementai)

• Sąrašo vaizdu (List view) (pavyzdžiai 35 ir 36 paveiksluose)

Konqueror programoje dar galima pasirinkti, kad elementai būtų rodomo medžiu, kaip tekstas,

keliais stulpeliais. 

Rodymo  tipą  galima  pasirinkti  Rodyti  (View) meniu,  Konqueror programoje   Rodyti  →

Rodymo būdas. Nautilus programoje dar galima pasirinkti Rodyti → Žiūrėti kaip (View →View

as) arba pasinaudoti Vietos juostoje esančiu Rodyti kaip (View as ...) išsiskleidžiančiu sąrašu.

Jei bylos ir katalogai rodomi kaip piktogramos galima jas rikiuoti pagal įvairius parametrus.

Nautilus programoje ši funkcija yra View → Arrange Icons. Leidžiama ikonas rikiuoti: 

• rankiniu būdų (manually); 

• pagal vardą (By name); 

• pagal dydį (By size); 

• pagal tipą (By type), 

• galima rikiavimą apversti (Reversed Order) ir t.t.

3 Piktograma yra žodžio ikona sinonimas. Angl. Icon
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Konqueror   programoje ši funkcija yra Rodyti → Rikiuoti. Čia leidžiama ikonas rikiuoti pagal

vardą skiriant ir neskiriant didžiąsias raides; pagal dydį, tipą; pirma išdėstant katalogus ir t.t.

Sąraše pateikiama ne tik bylos vardas (File name), bet ir dydis (Size), tipas (Type), paketimų

data (Date Modified), Konqueror dar rodomi ir kiti parametrai. Čia bylas taipogi galima rikiuoti –
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reikia  spragtelti ant  sąrašo  stulpelio  antraštės  ir  tada  surikiuojama  pagal  tą  parametrą,  šone

atsiranda rodyklė. Paveiksle 35 bylos yra surikiuotos pagal vardą žemyn; 36 paveiksle pagal dydį

žemyn didėjančia tvarka. Sąrašo pradžioje surūšiuoti katalogai, o žemiau – bylos).

4.6.2 Bylų ir katalogų tvarkymas

Bylų ir katalogų žymėjimas (selecting)

Bylų tvarkyklėse pažymėti bylas bei katalogus galima keliais būdais (lentelė 12)

12 lentelė

Užduotis Veiksmas

Pažymėti vieną elementą Apibraukite pele norimą objektą

Pažymėti  keletą  šalia  esančių
elementų

Apibraukite pele bylas ar  katalogus, kuriuos norite pažymėti
(apibraukimo pavyzdys pateiktas 37 paveiksle)

Pažymėti  keletą  išsibarsčiusių
objektų

Laikykite  nuspaudę  Ctrl  ir  tada  apibraukite  pele,  norimas
pažymėti bylas

Pažymėti  visą  katalogo  turinį
(visas bylas ir katalogus)

Meniu Keisti → Pažymėti viską (Edit  → Select  All  Files).
Arba galima pasinaudoti sparčiaisiais klavišais Ctrl - a

Byla ar katalogas atidaromi spragtelėjus. Kartais reikia spragtelti du kartus, priklausomai kaip

nustatyta. 

Bylų tvarkyklės pagalba su bylomis ir katalogais galima atlikti įvairius veiksmus: 

• Perkelti

• Kopijuoti, 
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• Sukurti simbolinę nurodą4

• Pervadinti

• Perkelti į šiukšlinę

• Ištrinti

Bylų ir katalogų perkėlimas, kopijavimas, nuorodų kūrimas

Yra keletas būtų kaip atlikti šiuos veiksmus.

• Tempimo (drag) pagalba:

1. Atsidarykite tvarkyklės langą. Tada pasirinkite Byla → Nauja (File → New Window).

Konqueror programoje Adresas → Naujas langas arba Dubliuoti langą.

2. Viename  lange  pasirinkite  katalogą,  iš  kurio  norite  perkelti,  nukopijuoti  bylą  ar

katalogą, o kitame katalogą, į kurį norite perkelti.

3. Tempkite norimą bylą ar katalogą į naująją vietą.. 

Nautilus programoje  byla  bus  perkelta  į  naują  vietą,  o  Konqueror  programoje

pasirodys  meniu,  kurioje  galėsite  pasirinkti  ką  norite  su  ta  byla  atlikti  –  perkelti,

nukopijuoti ar čia sukurti nuorodą į tą bylą.

Nautilus programoje  norėdami  nukopijuoti,  tempdami  nuspauskite  ir  laikykite  Ctrl

mygtuką, norėdami sukurti nuorodą toje vietoje nuspauskite ir laikykite Shift, o norint,

kad pasirodytų pasirinkimo meniu, tempiant nuspauskite Alt.

Atsirandančiame meniu yra šie punktai:

• Perkelti čia (Move here). Perkeliamas objektas į tą vietą

• Kopijuoti čia (Copy here). Padaroma objekto kopija.

• Sukurti nuorodą (Link here). Sukuria simbolinę nuorodą.

• Naudoti  fonui  (Set  as  Background).  Jei  objektas  yra  paveikslėlis,  jis

panaudojamas  vaizdo  srities  fonui.  Norint  sugrąžinti  įprastą  foną,  reikia

paspaudus dešinį klavišą iš meniu išsirinkti Use Default Background.

• kopijuoti (copy) ir įdėti (paste)

1. Pasirinkite bylą,  kurią  norite perkelti,  tada  pasirinkite Keisti (Edit)  →  Iškirpti (Cut

File) arba norėdami kopijuoti bylą Keisti → Kopijuoti.

2. Atsidarykite katalogą, į kurį norite perkelti ar nukopijuoti ir pasirinkite Keisti → Įdėti

(Paste File).

Šiuos veiksmus galima  atlikti ne tik per viršuje esantį  meniu,  bet ir dešiniu klavišu

iškviečiamą meniu. 

4 Simbolinė nuoroda – tai tam tikros rūšies byla, nurodanti į kitą bylą ar katalogą. Kai jūs atliekate tam tikrą
veiksmą su nuoroda, iš tiesų jūs atliekate tą veiksmą su byla ar katalogu, su kuriuo ji susijusi. Tačiau ištrindami
arba pervadindami nuorodą, ištrinate ar pervadinate tik ją, bet ne bylą ar katalogą, į kurią ji nurodo.
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• Tempti į reikiamą vietą šone esančiame medyje

1. Šoninėje  srityje atsidarykite medžio kortelę (Tree  Tab)  ir  nueikite į  reikiamą  vietą.

Konqueror programoje bylų medį atsidarysite Navigacijos pulte (ikonų juosta kairėje,

kuri iškviečiama F9 mygtuku) spragtelėję  Root katalogo ikoną.

2. Tempkite bylą ar katalogą iš vaizdo srities į reikiamą katalogą medyje.

Nautilus programoje  byla  bus  perkelta  į  naują  vietą,  o  Konqueror  programoje

pasirodys  meniu,  kurioje  galėsite  pasirinkti  ką  norite  su  ta  byla  atlikti  –  perkelti,

nukopijuoti ar čia sukurti nuorodą į tą bylą.

Nautilus programoje  norėdami  nukopijuoti,  tempdami  nuspauskite  ir  laikykite  Ctrl

mygtuką, norėdami sukurti nuorodą toje vietoje nuspauskite ir laikykite Shift, o norint,

kad pasirodytų pasirinkimo meniu, tempiant nuspauskite Alt.

Nautilus  programoje  su  pele  atliekant  aprašytus  perkėlimo,  kopijavimo,  nuorodų  kūrimo

veiksmus, atliekamą veiksmą parodo ir pasikeitęs pelės žymeklis. 

- perkeliant

- kopijuojant

- kuriant simbolinę nuorodą

- kai atsiranda pasirinkimo meniu

KDE aplinkoje  tik kopijuojant  bylą  prie  pelės  žymeklio atsiranda  pliusas.  Atliekant  kitus

veiksmus žymeklio išvaizda nesikeičia.

Katalogų kūrimas

1. Pasirinkite katalogą, kuriame norite sukurti naują katalogą.

2. Pasirinkite Byla  → Naujas  katalogas  (File  → New Folder),  Konqueror programoje

Keisti  →  Sukurti  naują  →  Katalogas.  Taipogi galima  pasinaudoti dešiniojo klavišo

meniu.

Sukuriamas bevardis katalogas.

3. Parašykite katalogo vardą ir paspauskite Enter.

Bylos ar katalogo vardo keitimas

1. Pažymėkite tą bylą ar katalogą, kurio pavadinimą norite keisti. 

2. Stovėdami ant  pažymėto objekto paspauskite dešinį  klavišą  ir  atsiradusiame  meniu

išsirinkite Pervadinti (Rename). Arba viršutiniame meniu išsirinkite Keisti → Pervadinti

(Edit → Rename).
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Perkelti bylą ar katalogą į šiukšlinę

1. Pažymėkite objektą (-us), kurį norite perkelti į šiukšlinę.

2. Pasirinkite Keisti → Perkelti į šiukšlinę (Edit → Move to trash). Taipogi šį veiksmą

galite atlikti naudodamiesi dešinio klavišo meniu.

Dar  vienas  būdas  –  galima  nutempti  bylą  ar  katalogą  į  Šiukšlinės  ikoną,  esančią

darbalaukyje.

Jei  į  šiukšlinę  perkeliant  diskelio  turinį,  svarbu  žinoti,  kad  jūsų  išmetamos  bylos  yra

perkeliamos  ne  į  kietajame  diske  esančią  šiukšliadėžę,  o  diskelyje  yra  sukuriamas  .Trash

katalogas  ir į  jį  patalpinamos išmetamos bylos. Norėdami šią šiukšlinę ištuštinti spauskite ant

darbastalio esančios Šiukšliadėžės ikonos ir ištuštinkite jos turinį.

Šiukšliadėžės (Trash) naudojimas

Į šiukšliadėžę galima perkelti:

• Bylas

• Katalogus

• Darbalaukio fono objektus

Perkėlus į šiukšliadėžę, tos bylos yra joje saugomos. Prireikus, jas galima iš ten vėl pasiimti. 

Šiukšliadėžės turinį galite peržiūrėti:

• Bylų tvarkyklės meniu pasirinkus Eiti → Šiukšliadėžė (Go To → Trash).

• Darbalaukyje vieną arba du kartus spragtelėjus ant šiukšliadėžės ikonos.

Šiukšliadėžės ištuštinimas:

• Nautilus programoje Byla → Ištuštinti šiukšliadėžę (File → Empty Trash)

• Darbalaukyje spragtelėkite dešinįjį pelės klavišą ant Šiukšliadėžės ikonos ir išsirinkite Ištuštinti

šiukšliadėžę (Empty Trash).

• Galima trinti nebūtinai visas bylas. Tada reikia nueiti į Šiukšliadėžės katalogą ir ištrinti norimas

bylas ar katalogus.

Būtina  žinoti,  kad  ištrynus  bylas  iš  šiukšliadėžės,  jos  galutinai  pašalinamos  iš  jūsų

kompiuterio.
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(GNOME)
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Bylų ar katalogų trynimas (Delete)

Atlikus trynimo veiksmą objektas yra galutinai ištrinamas iš kompiuterio, o ne perkeliamas į

šiukšlinę.

3. Pažymėkite objektą (-us), kuriuos norite ištrinti.

4. Pasirinkite  Keisti  →  Ištrinti  (Edit  →  Delete).  Taipogi  šį  veiksmą  galite  atlikti

naudodamiesi dešinio klavišo meniu.

Nautilus programoje, įprastai  Delete punkto nebūna  meniu. Norint, kad atsirastų, reikia tai

nurodyti nuostatose. Edit → Preferences → Desktop & Trash → Include a Delete command that

bypasses Trash (uždėti varnelę).

Leidimų (Permissions) keitimas

1. Pažymėkite bylą ar katalogą, kuriam norite pakeisti leidimus.

2. Iš  dešinio  klavišo meniu  išsirinkite Savybės  (Properties).  Pasirodo  Savybių langas,

pasirinkite Leidimų kortelę (paveikslai 41 ir 42).

Kaip matote pavyzdžiuose, leidimų kortelėje pateikiama informacija apie:

• Bylos savininką (File Owner);

• Bylos grupę (File Group);

• Priėjimo leidimai (ką su šia byla gali daryti įvairūs vartotojai)

1. Rodyti įrašus  (Read).  Kas  gali  matyti šią bylą? Pavyzdžiuose bylą gali matyti visi

vartotojai.

2. Įrašyti įrašus  (Write). Kas gali keisti bylos turinį? Pavyzdžiuose bylą gali keisti tik
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savininkas.

3. Vykdyti (Execute).  Ši savybė nurodo ar  tai  yra  vykdomoji byla  (programa)  ar  ne.

Vykdomosios  bylos  yra  2  rūšių  –  sukompiliuotos,  dar  vadinamos  dvejetainėmis

(binary) bei interpretuojamos, dar vadinamos skriptais (scripts). Niekada nebandykite

paleisti nežinomos vykdomosios bylos – ji gali ištrinti visus duomenis, esančius jūsų

asmeniniame kataloge !!!

Bylos savininkas bei tie, kam yra leista įrašyti gali pakeisti šiuos leidimus. Pvz. galite leisti

visiems vartotojams keisti vienos ar kitos bylos turinį, arba uždrausti net skaityti.

Bylų ar katalogų paieška

Jei nerandate kokios nors bylos ar katalogo galite pabandyti juos surasti:

1. Bylų paieškos įrankis yra pagrindiniuose GNOME ir KDE meniu. Be to, GNOME dar

ir Veiksmų meniu.

4.6.3 Darbas su lanksčiaisiais bei kompaktiniais diskeliais (CD)

Kaip jau minėjome - Linux OS visi įrenginiai jungiami prie bendro katalogų medžio.

Lanksčiųjų  diskelių  įrenginys  dažniausiai  jungiamas  prie  /floppy  (arba  /mnt/floppy),  o

kompaktinių diskų - prie /cdrom (arba /mnt/cdrom) katalogų.

Jei jūsų  Linux OS paleista  automatinio prijunginėjimo sistema  (automount)  pakanka  įkišti

reikiamą diskelį. Tada su bylų tvarkykle nuėjus į atitinkamą vietą (/floppy ar  /cdrom katalogą) į

ten ar  iš ten kopijuoti, trinti ir kurti naujas  bylas,  katalogus ir t.t.. Dažnai vartotojo patogumui

diskelių ar CD įrenginių ikonos įdedamos ir į darbalaukio foną. 

Jei nuėjus į atitinkamą katalogą nesimato diskelyje esančių bylų arba neleidžiama ten nieko

įdėti – vadinasi greičiausiai jūsų Linux OS nepaleista automatinio prijunginėjimo sistema. Tokiu

atveju prijungti (mount) ir atjungti (unmount) diskelių įrenginius prie bylų sistemos teks patiems.

Tai padaryti yra labai paprasta  – dirbant GNOME aplinkoje tereikia tuščioje darbalaukio fono

vietoje paspausti  dešinį  pelės  klavišą  ir  iš  atsiradusio  meniu išsirinkti  Disks  → CD-ROM ar

Disks→Floppy – žr.:  44 pav. Tuomet darbalaukio fone atsiras pasirinkto įrenginio ikona ir bus

galima dirbti – žr.: 43 pav. Baigus darbą su diskeliu būtina diskelį atjungti nuo bylų sistemos –

uždarykite  visas  programas,  kurios  gali  naudoti  diskelyje  esančias  bylas  ar  katalogus  ir

pakartokite anksčiau darytus veiksmus (tuščioje darbalaukio fono vietoje paspauskite dešinį pelės

klavišą ir iš atsiradusio meniu išsirinkite Disks→CD-ROM ar Disks→Floppy – žr.: 44 pav.) - taip

nuimsite varnelę nuo įrenginio, su kuriuo dirbote ir jo ikona dings iš darbalaukio.
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KDE aplinkoje prijungti ir  atjungti diskelių įrenginius taipogi nesunku – tereikia  paspausti

dešiniu pelės klavišu ant diskelio ar CD-ROM ikonos ir iš atsiradusio meniu išsirinkti Sumontuoti

(mount)  –  žr.:  45 pav.  Atjungimas  vyksta  analogiškai  –  dešinys  paspaudimas  ir  išsirenkama

Išmontuoti (Unmount)

Perspėjimas. Jokiu būdu neištraukite lankstaus diskelio iš įrenginio, prieš tai jo neatjungę nuo

bylų sistemos. Jūs galite prarasti visus duomenis, esančios diskelyje !!!
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4.6.4 Ikonos ir emblemos (Icons and emblems)

Nautilus programoje ant bylų ir katalogų ikonų galima uždėti emblemas. Tai mažos ikonos,

vaizdžiai  pažyminčios  bylą  ar  katalogą.  Emblemos  būna  įprastos  (default)  arba  laisvai

pasirenkamos.  Pavyzdžiui,  ant  jums  svarbios  bylos  galite  uždėti  emblemą  “Svarbu”  (47

paveikslas). Tai laisvai pasirenkama emblema.

13 lentelėje paaiškinama paveiksle pateikto pavyzdžio struktūra

13 lentelė

Komponetas Aprašymas

Tai emblema “Svarbu”.

Tekstinę bylą žyminti ikona. Ant kurios matosi realus bylos tekstas. 

Ikonos  pavadinimas.  Galima  keisti,  kokia  informacija  pateikiama
pavadinime.

Įprastos emblemos naudojamos:

• Simbolinėms nuorodoms

• Elementams, kuriems jūs turite šiuos leidimus:

• Tik skaitymo (peržiūros) leidimą

• Nei rašymo nei skaitymo leidimo

Įprastos  emblemos  keičiasi  priklausomai  nuo  pasirinktos  temos.  14 lentelėje  pateikiamos

įprastos temos įprastos emblemos.

14 lentelė

Įprasta emblema Aprašymas

Nuorodos  emblema.  Byla,  ant  kurios  yra  ši  emblema,  yra  simbolinė
nuoroda į kitą bylą
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Įprasta emblema Aprašymas

Skaitymo  emblema.  Bylą,  ant  kurios  yra  ši  emblema,  galima  tik
peržiūrėti

Rašymo ir skaitymo draudimo emblema.  Prie bylos,  ant  kurios yra  ši
emblema, jums neleidžiama prieiti.

Kitos emblemas galima pasirinkti taip:

1. Pažymėkite bylą ar katalogą, ant kurio norite uždėti emblemą.

2. Meniu  pasirinkite  Byla  →  Savybės  (File  →  Properties).  Arba  stovėdami  ant

pažymėto  elemento  paspauskite  dešinį  klavišą  ir  meniu  išsirinkite  Savybės

(Properties).

3. Nuostatų lange atsidarykite Emblemų (Emblems) kortelę (paveikslas 48) ir pasirinkite

norimą ir tai bylai labiausiai tinkančią emblemą.

Taipogi galima pakeisti ir ikonų standartinę išvaizdą:

1. Pažymėkite bylą ar katalogą, kurio ikoną norite pakeisti.

2. Nautilus meniu  pasirinkite  Byla  →  Nuostatos  (File  →  Preperties),  Konqueror

meniu Keisti → Savybės. Arba stovėdami ant pažymėto elemento paspauskite dešinį

klavišą ir meniu išsirinkite Savybės (Properties).

3. Pasirinkite kortele Bendros (Basic) ir Konqueror programoje spragtelėkite ant ikonos

paveikslėlio, o Nautilus programoje pasirinkite Select Custom Icon...

4. Atsiradusiame lange susiraskite jums labiau tinkantį ikonos paveikslėlį ir paspauskite
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Gerai (OK).

4.6.5 Bylų tvarkyklės pritaikymas (customizing)

Galima bylų tvarkyklę pritaikyti, kad labiausiai atitiktų jūsų poreikius.

Nautilus programoje  galima  keisti tvarkyklės nuostatas  (Preferences).  Keisti → Nuostatos

(Edit → Preferences).

Galima pakeisti nuostatas šiose kategorijose

• Įprasti vaizdo parametrai (View). 

• Nautilus  langų  bei  darbastalio  išvaizda  (Appearance).  Galima  pasirinkti  Nautilus  (langų,

elementų) išvaizdos temas.

• Naujų Nautilus langų elgesys bei matomi komponentai (Windows)

• Darbalaukio fono bei šiukšliadėžės elgesys (Desktop & Trash)

• Bylų  ir  katalogų  elgesys  piktogramų  bei  sąrašo  vaizduose  (Icon  &  List  Views).  Galima

pasirinkti, kada bylos atidaromos (spragtelėjus vieną ar du kartus), vykdomųjų bylų elgesį ir t.

t.

• Ikonų pavadinimuose pateikiama informacija (Icon Captions)

• Kortelės rodomos šoninėje srityje (Side Pane)

• Našumo parinktys, kad Nautilus būtų našesnis (Performance)

Konfigūruoti  Konqueror programą  taipogi galima.  Reikia  eiti Nustatymai  → Konfigūruoti

Konqueror.  Toliau  šoniniame  skydelyje  pasirinkite  Bylų  tvarkyklė.  Galėsite  keisti  keturių

kategorijų (atskirose kortelėse) parametrus:

• Elgesys

• Išvaizda

• Šiukšlių dėžė

• Peržiūros

Kitus darbo su bylomis ir katalogais nustatymus rasite kituose meniu punktuose (pvz.: bylų

rikiavimo, dydžio parametrus rasite meniu punkte Rodyti ir t.t.)

Rodyti ir slėpti lango komponentus

Nautilus  programoje  Rodyti  (View)  →  atitinkamas  komponentas  (pvz.  mygtukų  juostos

(Toolbars), Adreso juosta (Location bar) ir pan.)

Konqueror programoje Nustatymai → Rodyti → ...atitinkamą komponentą (pvz. meniu juostą,

papildomą įrankinę ir t.t.)
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Ar tam tikras lango komponentas yra matomas ar paslėptas nurodo varnelė prie atitinkamo

komponento. Jei ji yra – komponentas rodomas, jei nėra – paslėptas.

Turbūt pastebėjote, kad bet kuriai užduočiai atlikti yra keletas būdų. Kiekvienam vartotojui

leidžiama pasirinkti priimtiniausias iš jų.

4.7 Darbalaukio fonas (Desktop background)

Tai aktyvi grafinės aplinkos dalis. Jame galima atlikti šiuos veiksmus:

• Paleisti programas ir atidaryti bylas bei katalogus

Galima į darbalaukio foną įdėti objektus, kurie padėtų greitai pasiekti dažnai naudojamas bylas,

katalogus ar  programas.  Pavyzdžiui, galima  įdėti programos leistuką (launcher),  arba  įdėti

nuorodą į dažnai naudojamą bylą. Taipogi galima ir bylas bei katalogus laikyti darbastalio

fone. 

• Atidaryti darbalaukio meniu.

Darbalaukio fone paspauskite dešinįjį klavišą ir atidarysite meniu, kurio pagalba galima atlikti

įvairius veiksmus.

• Dirbti su šiukšliadėže

Galima tempti objektus į šiukšliadėžę ir išvalyti jos turinį.

• Prisitaikyti (customize) darbalaukio foną.

Galima keisti darbalaukio fono piešinį, spalvą.

Svarbu žinoti, kad darbalaukis yra katalogas, kurio turinys pateikiamas ekrane. Kelias iki jūsų

darbalaukio  katalogo  yra  /home/jūsų_vardas/desktop.  Taigi  norėdami  matyti  kokius  nors

objektus  darbastalio  fone,  galite  tiesiog perkelti,  nukopijuoti,  sukurti  simbolinę  nuorodą  į  tą

katalogą.

Įprastai darbalaukio fone būna trys objektai. Darbalaukio objektas – tai ikona, kurią galima

naudoti bylų, katalogų atidarymui, programų paleidimui. 15 lentelėje pateikiami įprasti GNOME

ir KDE darbalaukio fono objektai bei jų funkcijų aprašymai.

15 lentelė

Objektas Komponentas Funkcija

Vartotojo  namų
katalogas (Home)
1. GNOME 
2. KDE

Atidaromas  bylų  tvarkyklės  langas,
kuriame  pateikiamas  namų  katalogo
turinys.
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Objektas Komponentas Funkcija

Šiukšliadėžė
1. GNOME 
2. KDE

Atidaromas  bylų  tvarkyklės  langas,
kuriame pateikiamas šiukšliadėžės turinys

Pradėk  čia
(Start Here)
Tik  GNOME

terpėje

Atidaromas  Nautilus langas,  kuriame
pateikiami  svarbiausi  GNOME  terpės
komponentai

Naudojamos
Linux
distribucijos
(šiuo  atveju  -
Debian)
nuorodos

Atidaro  Konqueror programos  langą,
kuriame yra daug įvairių su Debian Linux
distribucija  bei  KDE  grafine  aplinka
susijusių  internetinių nuorodų.  Paspaudus,
jos  iš  karto  atidaromos  Konqueror
naršyklės lange

16 lentelėje aprašomi objektai, kuriuos galima patalpinti darbalaukio fone.

16 lentelė

Objekų rūšis Aprašymas

Simbolinė  nuoroda
(Symbolic link)

Simbolinė nuoroda  – tai objektas nurodantis į  kitą bylą ar  katalogą.
Darbalaukyje  spragtelėjus  ant  tokios  nuorodos  atidaroma  byla  ar
katalogas, kurią ji nurodo. 
Nuorodą galima atpažinti iš rodyklės emblemos. žr. skyrelį Ikonos ir

emblemos  

Leistukas (Launcher) Į darbalaukio foną galima pridėti leistukus:
• Programų – paleidžiama tam tikra programa
• Nuorodų – nurodo į tam tikrą bylą, katalogą ar URL

Byla (File) Galima  perkelti  bylas  į  darbalaukį.  Tada  jos  laikomos  darbalaukio
kataloge

Katalogas (Folder) Galima perkelti katalogus į darbalaukio foną arba jame sukurti naujus
katalogus. Tada jie laikomi darbalaukio kataloge. 

Darbalaukio fono objektus galima keisti:

• Pažiūrėti objekto savybes

• Pervadinti objektą

• Keisti objekto leidimus

• Keisti objekto ikoną

• Keisti ikonos dydį

• Uždėti emblemą ant objekto
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Kaip jau  minėta,  kadangi  darbalaukis  yra  tiesiog katalogas  (tik jo  turinys  atvaizduojamas

ekrane), tad dirbti su jo elementais reikia taip pat kaip ir su paprastais katalogais ar bylomis. Žr.

4.6.2 skyrelį. Arba visada galima naudoti tempimo funkciją dirbant su bylomis ar katalogais.

Darbalaukio fono meniu naudojimas 

Norint atidaryti šį  meniu reikia  paspausti  dešinį pelės klavišą,  stovint tuščioje darbalaukio

vietoje. 49 ir 50 paveiksluose pateikiama GNOME ir KDE darbalaukio meniu. 

17 lentelėje aprašyti abiejų grafinių aplinkų meniu punktai.

17 lentelė

Meniu punktas Grafinė
terpė

Funkcija

Naujas Langas (New
Window)

GNOME Atidaromas  naujas  Nautilus  langas,  kuriame  yra  namų
katalogas

Naujas katalogas
(New Folde)

GNOME Sukuriamas  naujas  katalogas  darbalaukio  fone.  Šis
katalogas patalpinamas darbalaukio kataloge.

Naujas terminalas
(New terminal)

GNOME Paleidžiamas naujas GNOME terminalas

Naujas leistukas
(New Launcher)

GNOME Sukuriamas naujas leistukas darbalaukio fone

Skriptai (scripts) GNOME Atidaromas  skriptų  submeniu,  kuriame  galite  pasirinkti
kokį skriptą paleisti (archyvavimo, išarchyvavimo, t.t.)

Surikiuoti pagal
vardą (Clean up by
name)

GNOME Darbalaukio fono objektai surikiuojami abėcėlės tvarka
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Meniu punktas Grafinė
terpė

Funkcija

Iškirpti bylas (Cut
Files)

GNOME Iškerpa  pažymėtas  bylas  ar  katalogus  ir  patalpina  į
iškarpinę

Kopijuoti bylas
(Copy Files) 

GNOME Nukopijuoja  pažymėtas  bylas  ar  katalogus  ir patalpina  į
iškarpinę

Padėti bylas (Paste
Files)

GNOME
KDE

Padeda bylas ar katalogus iš iškarpinės į norimą katalogą ar
darbalaukio meniu

Disks GNOME Leidžia  primontuoti  (prijungti)  lankstųjį  diskelį  (Floppy)
arba CD-ROM'ą.

Keisti darbalaukio
foną (Change Desktop
Background)

GNOME Paleidžiamas darbalaukio fono parinkčių įrankis leidžiantis
keisti foną.

Naudoti įprastą foną
(Use default
Background)

GNOME Gražinamas įprastas darbalaukio fonas

Sukurti naują KDE Atidaromas  yra  submeniu,  kuriame  galima  pasirinkti  ką
norite sukurti.

Žymelės KDE Atidaromas  yra  submeniu,  kuriame  leidžiama  redaguoti
žymeles

Atšaukti KDE Atšaukiamas  prieš  tai  darbalaukio  fone  įvykdytas
veiksmas

Padėti KDE Padeda bylas ar katalogus iš iškarpinės į norimą katalogą ar
darbalaukio meniu

Pagalba dėl
darbastalio

KDE Atidaromas  Konqueror  langas,  kuriame pateikiama  KDE
terpės pagalba

Paleisti komandą KDE Atsiranda  langas,  kurio  pagalba  galima  paleisti  norimą
programą ar URL.

Konfigūruoti
darbastalį

KDE Paleidžiamas  KDE  valdymo  modelis,  kuriame  galima
nustatyti įvairius darbalaukio parametrus

Leisti darbastalio
meniu

KDE Darbalaukyje atsiranda viršutinė meniu juosta

Langai laiptuotai KDE Gražiai sulygiuojami atidaryti programų langai

Lygiuoti piktogramas KDE Sulygiuojamos ikonos, jei jos buvo išmėtytos darbalaukio
fone

Rūšiuoti piktogramas KDE Atsiranda  submeniu,  kurioje  galima  pasirinkti  pagal  ką
rūšiuosite ikonas

Atnaujinti darbastalį KDE Atnaujinamas darbalaukis

Užrakinti ekraną KDE Užrakinamas ekranas, norėdami vėl prisijungti turite įvesti
slaptažodį

Išsiregistravimas KDE Atsijungiama nuo esamos sesijos ir pasirodo prisijungimo
ekranas.
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Darbalaukio fono spalvos bei piešinio keitimas

Galite keisti darbalaukio fono spalvas bei paveikslus pagal savo poreikius. Paprasčiausia tai

padaryti  naudojantis  Darbalaukio  fono  įrankiu  (51 paveikslas),  kuris  iškviečiamas  per

darbalaukio fono meniu.

Galima pasirinkti paveikslėlį (Select picture), kuris bus naudojamas  jūsų darbalaukio fonui.

Galima naudoti sistemoje esančius bei savo turimus paveikslėlius. Toliau paveikslėlio parinktyse

(Picture  Options)  galima  pasirinkti  kaip  bus  vaizduojamas  paveikslėlis  darbalaukio  fone:

pakartojant  (wallpaper),  viduryje  (center),  padidintas  (scaled),  ištemptas  (streched)  ar

nerodomas  (no picture).  51 paveiksle  yra  pasirinktas  pastarasis  variantas  (jis  yra  įspaustas).

Taipogi galima pasirinkti ir fono stilių (background style) ar  bus vientisa spalva,  vertikalus ar

horizontalus perėjimas (vertical, horizontal gradient) ir pasirenkama norima spalva.

KDE aplinkoje darbalaukio fono ketimo parinktys galima  rasti  dešiniu klavišu iškviestame

meniu  išsirinkite  Konfigūruoti  darbastalį...  ir  šoninėje  srityje  pasirinkite  Fonas  (žr.  52

paveikslėlį).  Fono keitimo parinktys  yra  panašios  kaip  ir  GNOME aplinkoje,  tiesiog jos  yra

išdėstytos kitaip.
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Baigus darbą v  isada tvarkingai išjunkite kompiuterį:  

1. Atsijunkite nuo grafinės aplinkos. GNOME aplinkoje „Pagrindinis“ arba „Veiksmų“ meniu ir

„Atsijungti“ (Logout), KDE terpėje - „Pagrindinis“ meniu ir „Išsiregistruoti“

2. Registravimosi  programoje  išsirinkite  komandą  „Išjungti“  (Shutdown).  GNOME

registravimimosi programoje šią komandą rasite paspaudę meniu (mygtuką) „Sistema“.

3. Palaukite  kol  kompiuteris  pats  išsijungs  arba  atsiras  užrašas  Power  Down  ir  tik  tada

paspauskite kompiuterio korpuse esantį išjungimo mygtuką.
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